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Object Research Systems

This document describes the new features, product enhancements, and other 
improvements implemented in the Dragonfly and Dragonfly Pro 3.5 software release. 
You should read these release notes carefully before you install this new version.
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New Features
The 3.5 software release for Dragonfly and Dragonfly Pro provides the following new 
features. For information about product enhancements and other changes, such as new 
registration methods and other improvements for aligning slices in an image stack, 
visual effects for clipped regions, optimized lighting controls, and support for time-
enabled data, see Product Enhancements and Other Changes on page 28.

Active Contour
You can use the new Active Contour tools to quickly and efficiently complete 
segmentation tasks by adding a series of paths to the 2D views of volumetric image 
data and then generating a mesh that fully describes the surface of the targeted feature 
of interest.

In the example below, a surface mesh was generated from the marked paths added to 
the contour of the femoral head, neck, and top of the thigh bone. Marked paths are 
shown in orange, while the generated surface mash appears in blue. 

Surface mesh generated with the Active Contour tools
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Choose Tools > Active Contour on the menu bar to open the Active Contour panel, 
shown below.

Active Contour tab

The Active Contour panel includes tools to create a group of paths, draw paths in 
Freehand or Snap mode, edit paths, and iterate selected paths.

You can generate a surface mesh that describes the segmentation target after the 
required number of paths have been added to a group. Generated meshes are added 
automatically to the Data Properties and Settings panel.
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Overlay Panel
Image and text overlays can now be added to 2D and 3D scene views to illustrate 
findings with text, graphs, screen captures, and other information. For example, you 
can display a corporate or institutional logo as an image overlay over an animated 
sequence and annotate key frames with titles and captions that describe important 
transitions.

3D view with image and text overlays

The overlays available on the Overlays panel, shown below, can be included in animated 
sequences and screen captures and can be saved with a session or in the .ORSObject 
file format.

Overlays panel

The following overlay options are available in Dragonfly 3.5.

Options for overlays

Description

Image Adds a selected image to the current scene view, such as a company or 

institutional logo, graph, or image captured from Dragonfly. Images can be 

resized and positioned as required, and opacity is adjustable.

Text Adds a text overlay to the current scene view. The text color, font face, size, 

and alignment are selectable in the Overlay Editor and opacity is adjustable. 

Text overlays can be resized and positioned as required.
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The options for editing overlays are available in the Overlay Editor, shown below.

Text Overlay Editor

Shapes Panel
This Dragonfly release features a new Shapes panel. Shapes are fully editable 
geometrical forms that can be added to a scene to enhance 3D visualizations of selected 
objects. The visual effects for shapes — boxes, capsules, cylinders, planes, and spheres 
— include clipping, edge contrast, fill, look-up table functions, and window leveling. 
These effects can be applied to volumetric image data, regions of interest, multi-ROIs, 
and meshes.

In the example below, multiple shapes with different effects — clip, edge contrast, and 
a look-up table — were applied to volumetric image data.

Shapes and visual effects

The visual effects that you create with the shapes available on the Shapes panel can be 
included in animated sequences and in screen captures.

Shapes panel
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The different geometrical forms available in the Shapes panel — Box, Capsule, Cylinder, 
Plane, and Sphere — are described in the table below.

Types of shapes

Description

Box Creates a basic box-shaped object, or cuboid, that has six flat sides. All of its faces are rectangles and all 

of its angles are right angles.

You can resize and rotate the box, as well as change its position within a 2D or 3D view with the control 

points.

Capsule Creates a three-dimensional geometric shape consisting of a cylinder with two hemispherical caps on 

each end.

You can increase or decrease the height and radius of the capsule, rotate it, as well as change its position 

within a 2D or 3D view with the control points.

Cylinder Creates an object with two identical flat ends that are circular and one curved side. The cylinder has the 

same cross-section from one end to the other.

You can increase or decrease the height and radius of the cylinder, rotate it, as well as change its position 

within a 2D or 3D view with the control points.
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Each shape that is created or imported appears on a separate line in the top section of 
the Data Properties and Settings panel, as shown below. The bottom section contains a 
list of all available objects — volumetric image data, regions of interest, multi-ROIs, and 
meshes — to which shape effects can be applied. You should note that it is possible to 
apply shape effects to multiple objects and to apply multiple effects simultaneously.

Shape properties and settings

Plane Creates a flat, two-dimensional surface.

You can rotate the plane, as well as translate it with the handle.

Sphere Creates a 3D object shaped like a ball, in which every point on its surface is the same distance from the 

center.

You can resize a sphere, as well as change its position within a 2D or 3D view.

Description
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The visual effects described below can be applied to data that corresponds either to the 
inside or outside of the selected shape.

Visual effects for shapes

Example Description

Clip If checked, the data of the selected visuals that corresponds to the inside 

or outside of the shape will be clipped.

Edge Contrast* If selected, the intensity values of selected image data that correspond to 

the inside or outside of the shape will be modulated with the values of 

their gradient modulus to produce an image in which edges are 

emphasized and other features are semi-transparent.

The degree of contrast can be adjusted with the Contrast slider, as 

shown below.

Fill** If selected, voxels contained within the inside or outside of the shape will 

be filled with a solid color.

To select a fill color, click the color swatch and then choose a color in the 

Color dialog.
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  * Applicable to selected image data and image data corresponding to selected regions of interest and multi-ROIs.

 ** For selected image data, all voxels within the bounding box will be considered. For selected regions of interest and multi-ROIs, only labeled 

voxels will be considered. For selected meshes, only voxels that correspond to the surface of the mesh will be considered.

In some cases, you may find it advantageous to apply multiple effects to selected 
visuals. For example, edge contrast, window leveling, and a look-up table. You should 
note that Dragonfly applies selected effects in the order in which they appear in the 
Effects panel. Reordering effects will have an impact on the final look of the visual by 
either subtly or dramatically changing its appearance. 

Lookup Table and

Absolute LUT*

If selected, a lookup table function (LUT) or an absolute LUT will be 

applied to the image data of selected visual(s) that corresponds to the 

inside or outside of the shape. LUTs determine how regions within 

specific arrays of intensity are highlighted and how color is applied.

Look-up tables can be selected in the drop-down menu, as shown below.

NOTE  If you choose an absolute LUT, color mapping will be applied 

independently of window leveling. This means that the colors mapped to 

specific values will be retained whenever leveling values are changed. 

For regular LUT functions, colors will be remapped to the range of values 

defined by the window width.

Window Leveling* If selected, new window level values can be applied to the image data of 

selected visual(s) that corresponds to the inside or outside of the shape.

The width of the window, as well as its center value, can be selected with 

the Width and Center sliders, as shown below.

Example Description
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You can reorder selected effects with the Up and Down buttons on the right side of the 
panel, as shown below.

Reordering effects

Shape Options
A number of options — Create Structured Grid, Extract a Structured Grid, and Add/
Remove from a Region of interest — are available in the pop-up menu for shapes.

Create a Structured Grid
Creates a dataset (structured grid) from the subvolume defined by the box shape. The 
dataset type created can be a channel, region of interest, or multi-ROI, and the input 
data and geometry can be selected in the appropriate dialog — Create a Channel, 
Create an ROI, or Create a Multi-ROI.

Create a Channel dialog

Extract a Structured Grid
Extracts a dataset (structured grid) from the subvolume defined by the box shape and 
the intersecting data values of a selected object.

Modifying Regions of Interest
The following options are available for modifying regions of interest with the shapes 
available on the Shapes panel.
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Add to ROI… Adds all voxels contained in the subvolume defined by the current shape to 
a selected region of interest. You should note that only intersecting voxels will be added 
to the region of interest.

Remove from ROI… Removes all intersecting voxels of the subvolume defined by the 
shape from the selected region of interest.

New Features for Meshes
A number of new options are available in Dragonfly 3.5 for working with meshes. You 
can reduce the number of vertices, edges, and triangles in a mesh, register meshes to a 
reference, manage scalar information, and select sampling rates for generating 
thickness meshes from regions of interest. These new features are described in the 
following topics.

Mesh Decimator
This Dragonfly release provides a Mesh Decimator, for cases in which you need to 
reduce the number of vertices, edges, and triangles in a mesh. Surface simplification is 
one way to enable real-time, interactive visualization of large, complex meshes.

The example below illustrates a progressive mesh decimation.

Decimated meshes

Dragonfly’s new Mesh Decimator lets you choose a decimation method and a reduction 
target. The overall shape, volume, and boundaries of the original mesh will be 
preserved as much as possible during the simplification process.

Right-click the required mesh in the Data Properties and Settings panel and then choose 
Mesh Decimator in the pop-up menu to open the Mesh Decimator panel.

Original mesh Original mesh decimated by 75%Original mesh decimated by 50%
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Mesh Decimator panel

The following parameters are available for decimating meshes.

Parameters available for the Mesh Decimator

Mesh Registration
Dragonfly's new iterative closest point registration workflow can automatically register 
meshes by applying the rotation and translation that best aligns the selected mesh with 
a reference. Right-click the required mesh in the Data Properties and Settings panel and 
then choose Mesh Registration in the pop-up menu to open the Mesh Registration 
panel, shown below.

Mesh Registration panel

Description

Mesh Indicates the currently selected mesh, to which the decimation will be applied. If required, you can select 

another mesh in the drop-down menu.

Method Two methods are available in Dragonfly to reduce the number of vertices, edges, and triangles  in a mesh 

— Pro decimation and Quadric decimation. These methods work by the iterative elimination of 

components identified through local geometric optimality criteria. You should note that both methods will 

attempt to preserve the overall shape, volume, and boundaries of the original mesh as much as possible.

Target decimator Lets you set the target reduction as a percentage ([0,1]) of components to be removed. For example, if the 

mesh contains 100 triangles and a Target Reduction of 0.90 is set, there will be approximately 10 

triangles, a 90% reduction, after the decimation.

NOTE If the cost of removing a component is too high, then it will not be removed and the selected target 

reduction may not be reached.

Create new mesh Lets you choose an output target — at the input so that the original mesh is transformed, or at the output 

so that a new mesh is created and the original remains unmodified.

NOTE Whenever possible, you should try to retain the original mesh so that you can compare the original 

and reduced versions.
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Deviation Maps
For analysis and visualization purposes, you can compute and generate color-coded 
meshes showing the deviation (distance) between the normals of two sets of meshes. 
Referential values are color-mapped according to the applied look-up table (LUT) and 
the type of distance map requested — signed or unsigned. Distance maps can be 
examined in 3D and 2D views. 

Deviation (distance) map measurements are added to the selected mesh and appear in 
Scalar information box, as shown below.

Mesh scalar information

Map Scalar Values
This new option for Dragonfly 3.5, which is available in the Mesh pop-up menu, lets you 
map selected measurements contained within a scalar mesh to another mesh or multi-
ROI.

You can choose the scalar values you want to map to the selected mesh in the Choose a 
scalar value dialog, shown below.

Choose a scalar value dialog

NOTE Mapping for meshes to meshes is done with a closest face matching criteria, while 
mapping for meshes to multi-ROIs is done through corresponding world coordinates.

Copy Scalar Values
This additional option for Dragonfly 3.5, which is available in the Mesh pop-up menu, 
lets you copy selected measurements contained within a scalar mesh to another mesh.

You can choose the scalar values you want to copy to the selected mesh in the Choose a 
scalar value dialog, shown below.

Choose a scalar value dialog
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Delete Scalar Values
This new option for Dragonfly 3.5, which is available in the Mesh pop-up menu, lets you 
delete selected measurements from scalar meshes.

You can choose the measurements you need to delete from a selected mesh in the 
dialog shown below.

Choose a scalar value to delete dialog

Sampling Rates for Generating Thickness Meshes
For analysis and visualization purposes, Dragonfly can compute and generate color-
coded meshes that show the referential values of the local thickness between boundary 
points. Thickness is calculated as the diameter of a hypothetical sphere that fits within 
each boundary point.

As a new option for this software release, sampling rates for thickness meshes exported 
from regions of interest are selectable.

Export options for thickness meshes

NOTE The use of simplified models is one way to enable real-time, interactive visualization of 
large, complex meshes.

Export Meshes in VTK File Format
This Dragonfly release provides the option to export meshes in the VTK file format. 

New Options for Regions of Interest
A number of new options are available in Dragonfly 3.5 for working with regions of 
interest. You can interpolate 2D regions, align axes of inertia, generate contour meshes, 
and perform other functions. These new features are described in the following topics.

Interpolate ROI
The new Interpolate operation for regions of interest lets you interpolate 2D regions 
through volumetric image data to create a 3D region of interest. You can choose the 
direction of the interpolation.

In the following example, a series of 2D regions were defined on a few slices in the XY 
oriented view (on left) and then interpolated in the Z axis. The results of the 
interpolation are shown on the right in an XZ oriented view.
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Interpolated region of interest

The Interpolate option for regions of interest, circled below, is available in the 
Operations box on the ROI Tools panel.

Operations box

Generate Contour Mesh
In this Dragonfly release, you can generate contour meshes that describe the surface of 
a region of interest in the Generate Contour Mesh panel.

In the following example, three contour meshes with different threshold values were 
generated from a region of interest created on the femoral head and neck of a thigh 
bone.

Contour meshes (maximum threshold in white, mid in orange, minimum in blue)

The settings for generating contour meshes are available in the Generate Contour Mesh 
panel. Right-click the required region of interest in the Data Properties and Settings 
panel and then choose Generate Contour Mesh to access the panel.



Release Notes Version 3.5
New Features 19

Object Research Systems

T
M

0
2

1
-A

-0
3

Generate Contour Mesh panel

New Binary Image from ROI
Automatically creates a new dataset(s) in which the labeled voxels in the selected 
region(s) of interest are assigned a value of 1 and unlabeled voxels are assigned a 
value of 0.

Invert
You can now invert the voxels in a region of interest, or multi-ROI, and change the 
order of axes in which they are read.

The settings for inverting regions of interest are available in the Dataset Inverter panel, 
shown below. Right-click the required region of interest in the Data Properties and 
Settings panel and then choose Invert to access the panel.

Dataset Inverter panel

Align Axis of Inertia
This new option, which is available in the Region of Interest pop-up menu, lets you 
automatically align the axis of inertia of a selected region of interest with the axis of 
inertia of another region of interest.

Look at Center of Mass
The new option automatically aligns the center of mass of the selected region of 
interest in the current 2D scene views. You should note that the center of mass is 
calculated from the labeled voxels contained within the bounding box of the region of 
interest.
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Visual Effects for Regions of Interest
This Dragonfly release includes a series of visual effects that can be applied to a region 
of interest to enhance 3D visualizations of segmented features. Visual effects for 
regions of interest are available at the bottom of the Data Properties and Settings 
panel, as shown below.

Visual effects for regions of interest

The visual effects available for regions of interest, and their associated properties, are 
described in the following table.

Visual effects and properties for regions of interest

Example Description

Original ROI Included for reference purposes. This is the original appearance of the region of 

interest, with a highlight applied.

Clip If selected, all data that corresponds to the region of interest will be clipped.

Edge Contrast If selected, the intensity values of image data that correspond to the region of 

interest will be modulated with the values of their gradient modulus to produce an 

image in which edges are emphasized and other features are semi-transparent.

The degree of contrast can be adjusted with the Contrast slider, as shown below.
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Fill If selected, voxels that correspond to the region of interest will be filled with a 

solid color.

To select a fill color, click the color swatch and then choose a color in the Color 

dialog.

LUT and

Absolute LUT

If selected, a lookup table function (LUT) or an absolute LUT will be applied to 

image data that corresponds to the region of interest. LUTs and Absolute LUTs 

determine how regions within specific arrays of intensity are highlighted and how 

color is applied.

Look-up tables can be selected in the drop-down menu, as shown below.

NOTE  If you choose an absolute LUT, color mapping will be applied 

independently of window leveling. This means that the colors mapped to specific 

values will be retained whenever leveling values are changed. For regular LUT 

functions, colors will be remapped to the range of values defined by the window 

width.

Window Leveling If selected, new window level values can be applied to image data that 

corresponds to the region of interest.

The width of the window, as well as its center value, can be selected with the 

Width and Center sliders, as shown below.

Example Description
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New Options for Multi‐ROIs
A number of new options are available in Dragonfly 3.5 for working with multi-ROIs. You 
can copy scalar values from one multi-ROI to another, as well as delete scalar values. 
These new features are described in the following topics.

Copy Scalar Values
This additional option for Dragonfly 3.5, which is available in the Multi-ROI pop-up 
menu, lets you copy selected measurements contained within a multi-ROI to another 
multi-ROI.

You can choose the object that includes the scalar values you want to copy to the 
selected multi-ROI in the Choose a scalar value dialog.

Choose a scalar value dialog

Delete Scalar Values
This new option for Dragonfly 3.5, which is available in the Multi-ROI pop-up menu, lets 
you delete selected measurements from multi-ROIs.

Orthographic Projection Mode
Dragonfly now offers the opportunity to view objects in both perspective and 
orthographic projection modes. In the familiar and default perspective mode, objects 
are subject to foreshortening and will appear smaller as their distance from the camera 
increases. In the parallel projection of orthographic mode, there is no foreshortening or 
vanishing point and dimensions can be communicated unambiguously.

Although perspective viewpoints can provide more information about depth and often 
tend to appear more realistic, orthographic viewpoints can make it much easier to 
compare objects, such as the parts of a molecule, as there is no question about how the 
viewpoint may affect the perception of distance or size. In addition, a scale bar is 
available for orthographic views.
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Perspective (on left) vs. orthographic (on right) projections

While working, you can easily switch between orthographic and perspective modes to 
get a better sense of an object. Orthographic projection mode is selectable on the 
Scene’s Views Properties panel and in the pop-up menu for 3D views. You can also 
choose Orthographic as the default projection mode (see 3D Views Preferences on 
page 40).

NOTE Some lighting controls, such as shadowing and material properties, are not available for 
orthographic projections.

Scale Bar for Orthographic Views
A floating scale bar is available for 3D views showing orthographic projections to show 
the relative size of an object. If required, you can re-position the scale bar by dragging 
it anywhere inside the view, as well as set its length.

Scene View Orientation Panel
The options in the new Scene View Orientation panel, shown below, let you view and 
precisely adjust the angles of rotation — Yaw, Pitch, and Roll — of a selected 2D or 3D 
view, as well as to modify the position of the camera. Additional options for 2D views let 
you navigate to the different slices contained in volumetric image data.

Scene View Orientation panel
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Auto Processing
The Auto Process Stack feature for Dragonfly 3.5 enables real-time automatic 
processing of serial section 2D stack experiments. Instead of having to wait for the 
entire image stack to be available, you can set required operations — such as filtering, 
registration, classification, or any operation saved in a macro — to be applied 
automatically to new images as they arrive and interactively monitor the results as the 
3D image channel grows.

Choose Tools > Auto Process Stack to open the Auto Process Stack panel.

Auto Process Stack panel

It’s possible to indicate the time interval at which you’d like to have Dragonfly check for 
new images, as well as to select tasks that have been saved from previous jobs. 
Applicable tasks include classification with a saved classifier, slice alignment with 
Dragonfly’s powerful matching methods, image filtering, and operations saved in a 
macro file.

When you’re ready, simply click the Start the Auto Process button. As new images 
become available in the monitored folder, Dragonfly will process then according to the 
defined parameters and integrate them into a 3D image channel that can be volume 
rendered with a lookup table (LUT). If necessary, image stacks can be re-processed. 

NOTE This feature is available only for TIFF images and for operations that use a single 
channel. All images must have the same pixel size and the same matrix dimensions.

NOTE The Auto Process Stack feature is not included in the standard Dragonfly installer. 
Contact Object Research Systems to request a copy of this module.
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2D View Text Annotations
This Dragonfly release includes additional text annotations for rotating 2D scene views 
around its Z axis (Roll) and for navigating between the time steps of time-enabled 
image data. These text annotations are circled below.

Text annotations for 2D views

Advanced Options and New Filters for Image Processing
A number of new options and filters are available in Dragonfly 3.5 for processing image 
data.

Advanced Options
The Advanced Options for image processing let you process multi-scale images in 
selected operations, as well as select different geometries and data types for your 
image processing outputs. You should note that multi-scale images are images with 
different geometries and/or image spacing.

To enable the Advanced Options, check Advanced Options in the Operations box, as 
shown below.

Advanced Options for image processing
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New Filters
The following new filters are available in this software release.

Frangi Filter… The newly added Frangi filter is typically used to detect vessel-like or 
tube-like structures and fibers in volumetric image data. The screenshots below 
demonstrate the results of applying the Frangi filter to the image data of lung tissue on 
a coronary computed tomography (CT) scan.

Original image in MIP mode (left) and result after processing with Frangi filter (right)

Frequency Domain Filters… Two new filters, Discrete Fourier Transform and Inverse 
Discrete Fourier Transform, are available for working in the frequency domain.

Gradient and Divergence Filters… Available for Arithmetic operations, these filters are 
designed to extract information from images. The Gradient filter shows how quickly 
intensity values change from pixel to pixel, while the Divergence filter, which is the 
inverse of the Gradient filter, indicates minor gray scale variations.

Default Output for Arithmetic Operations
With this software release, all calculations and the default output for arithmetic 
operations are automatically set to the float data type. There is no longer any need to 
format operations with a decimal, such as 2.0*A, to avoid wrapping. You should note 
that if you select integer as the output data type, calculations will still be done in float, 
but results may be clipped.

Modified Filters
Two previously available filters for detecting edges — Prewitt and Scharr — now default 
to a combined mode, in which horizontal and vertical edges are extracted. You should 
note that options for detecting horizontal and vertical edges separately are still available 
for these filters.

New Options for Image Data
New functions are available in Dragonfly 3.5 for extracting datasets from marked slices, 
normalizing image data to a reference, and overwriting dataset values.

New Dataset from Marked Slices
Lets you extract a new dataset from the marked image slices of volumetric image data.

Normalize Histogram
Lets you normalize the histogram of a selected dataset to the histogram of another 
dataset.
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Overwrite Dataset
Lets you overwrite the intersecting values of a selected dataset with the values of 
another dataset.

New Options for Selected Objects
The following new options are available for image data, regions of interest, multi-ROIs, 
and meshes in the Data Properties and Settings panel pop-up menus.

Align Centroids
This pop-up menu item lets you automatically align the centroid of the selected object 
with the centroid of another object. Applicable objects include volumetric image data, 
regions of interest, multi-ROIs, and meshes. Reference objects can be selected in 
Choose the object to align with dialog, as shown below.

Choose the object to align with dialog

Apply Transformations
To help maintain consistency when you work with multiple objects, you can apply the 
transformations, such as translations and rotations, that were applied to a reference 
object to another object. You should note that only objects that were translated and/or 
rotated, will be available in the Choose an object dialog as the reference.

Choose an object dialog

Support for CZI Files
This software release provides support for importing and visualizing CZI files, a format 
used by ZEISS microscopes to save data, such as image stacks and time lapse series. 
Available for Dragonfly Pro only. Contact Object Research Systems for information 
about the availability of Dragonfly Pro.
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Product Enhancements and Other Changes
This release provides the following product enhancements for Dragonfly and Dragonfly 
Pro. For information about new features, such as the Active Contour tools, overlays, and 
shapes, see New Features on page 5.

Updates for Aligning Image Slices
This Dragonfly release provides a number of powerful new options and tools for 
properly aligning an image stack into a correct 3-dimensional model that ensures 
accurate image processing and analysis.

Choose Dataset Slices Registration in the Data Properties and Settings pop-up menu to 
open the Slice Registration panel shown below.

Slice Registration panel

Registration Methods
The following additional registration methods are available in this Dragonfly 3.5 
software release.

Enhanced Correlation Coefficient… Implements an area-based alignment that builds on 
intensity similarities.
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Feature Base… Matches features between image slices by detecting corners, which are 
regions in the image with large variations in intensity in all directions. The preview for 
Feature Base comparisons, shown below, stacks two images horizontally and draws 
lines from the first image (the currently displayed slice in the workspace) to the next 
slice and shows the best matches for the number of features requested for the preview.

Preview for Feature Base registration

Template Matching… Provides a method for searching for and finding the location of a 
template image in the larger images within the 3D image stack. This registration 
method simply slides the template image over the input image (as in 2D convolution) 
and compares the template and patch of input image under the template image.

The preview for template matching, shown below, returns a grayscale image, in which 
each pixel denotes how much the neighborhood of that pixel matches with the 
template.

Matching result for a detected template

Selection Box Options
A number of new options are available for the selection box, which provides a mask for 
the registration inputs.
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Follow Template… The Follow Template option for selection boxes lets you add a 
template that will be applied to subsequent slices during processing. It is a type of 
floating selection box.

Template Matching option

Selectable Slice Ranges… The options in the Slice Range box, shown below, let you 
select a range of images within the stack to which required transformations will be 
computed. You should note that any transformation applied to the last slice in the range 
will also be applied to the remaining slices in the image stack.

Slice Range option

Visual Effects for Clipped Regions
The Clip tool allows you to interactively clip image data, regions of interest, multi-ROIs, 
and meshes along orthogonal planes in 3D views. This Dragonfly release introduces 
additional visual effects, such as look-up table functions, edge contrast, and window 
leveling, that can be applied to the clipped region of selected objects.

Visual effects for clipped regions are available on the Clip panel, as shown below.

Visual effects for clip boxes

The following effects can be applied to the currently checked object or objects.
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Clip effects and properties

Example Description

Clip If selected, the data of selected visual(s) that corresponds to the 

inside or outside of the Clip box will be clipped.

NOTE In this Dragonfly release, Clip is applied as the default setting 

applied to volumetric image data, regions of interest, multi-ROIs, and 

meshes. You may have to remove this visual effect when you create 

exploded views.

Edge Contrast* If selected, the intensity values of selected image data that 

corresponds to the inside or outside of the Clip box will be modulated 

with the values of their gradient modulus to produce an image in 

which edges are emphasized and other features are semi-

transparent.

The degree of contrast can be adjusted with the Contrast slider, as 

shown below.

Fill** If selected, voxels contained within the inside or outside of the Clip 

box will be filled with a solid color.

To select a fill color, click the color swatch and then choose a color in 

the Color dialog.
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  * Applicable to selected image data and image data corresponding to selected regions of interest and multi-ROIs.

 ** For image data, all voxels within the bounding box will be considered. For regions of interest and multi-ROIs, only labeled voxels will be 

considered. For meshes, only voxels that correspond to the surface of the mesh will be considered.

LUT and

Absolute LUT*

If selected, a lookup table function (LUT) or absolute LUT will be 

applied to selected data that corresponds to the inside or outside of 

the Clip box. LUTs determine how regions within specific arrays of 

intensity are highlighted and how color is applied.

Look-up tables can be selected in the drop-down menu, as shown 

below.

NOTE  If you choose an absolute LUT, color mapping will be applied 

independently of window leveling. This means that the colors mapped 

to specific values will be retained whenever leveling values are 

changed. For regular LUT functions, colors will be remapped to the 

range of values defined by the window width.

Window Leveling* If selected, independent window level values can be applied to the 

data of selected visual(s) that corresponds to the inside or outside of 

the Clip box.

The width of the window, as well as its center value, can be selected 

with the Width and Center sliders, as shown below.

Example Description
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Measurement Inspector
The Measurement Inspector available for multi-ROIs and scalar meshes now includes a 
Measurement range selector, circled below, that lets you select the range of data that 
will be plotted in the histogram. 

Measurement Inspector

Options in the Measurement range box also let you copy the range of other 
measurements, either from the current multi-ROI or another multi-ROI, to the currently 
selected measurement. You can also reset the range to the original values.

Export Options… Additional updates to the Measurement Inspector include Export 
options in the In window and Out window rendering boxes, which let you create a new 
multi-ROI that includes all of the labeled objects that correspond to the selected range.

3D Settings
This Dragonfly release includes a new setting — Hard gradient — for modifying the 
appearance of volumetric image data in 3D views. This option, circled below, is 
available in the 3D settings box on the Data Properties and Settings panel.

3D settings
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Scene’s Views Properties
In addition to accelerated rendering that lets you to easily combine 3D renderings, 
regions of interest, and meshes in the same 3D view, this Dragonfly release also 
features new lighting controls and an auto-focus option.

These updates, circled below, are available on the Scene’s Views Properties panel.

Scene’s views properties for 3D views

Shadow Opacity
Lets you adjust the opacity of shadows cast on and by objects in 3D views.

Auto Focus
An Auto focus option is now available for automatically optimizing the focus of the 
camera within a 3D view.



Release Notes Version 3.5
Product Enhancements and Other Changes 35

Object Research Systems

T
M

0
2

1
-A

-0
3

Points Tool
A number of updates — Auto generate caption and Export — are available for the Points 
tool in this software release.

Auto Generate Caption
Lets you automatically generate captions that show the position or value of each point 
added to 2D and 3D views.

Options for generated captions

Data Export
Lets you export Points data in the CSV file format.

NOTE The new options for the Points tool also includes configurable control points (see 
Configurable Control Points for Annotation Tools on page 35).

Path Tool
Options for the Path tool now include the function to profile intensity along the full 
length of a selected path. The resulting profile intensity graph indicates the maximum, 
minimum, and mean data values along the path.

NOTE The new options for the Path tool also includes configurable control points (see 
Configurable Control Points for Annotation Tools on page 35).

Configurable Control Points for Annotation Tools
You can now modify the appearance of the control points of an annotation by selecting 
their size and style. These options, which are applicable to rulers, angles, regions, and 
points, are available in the Data Properties and Settings panel as shown below.

Annotation properties
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Additional Support for Time‐Enabled Data
This Dragonfly release features additional support for importing and examining time-
enabled data.

T Size for Importing Raw Data
For time-enabled data you can now enter the number of time steps in the T edit box, 
circled below. You should note that changing the number of time steps will 
automatically adjust the size of the image stack (Z axis).

Import Datasets dialog

Navigation Tools
This Dragonfly release includes additional options for navigating through time-enabled 
datasets. These include a Time Step text annotation (see 2D View Text Annotations on 
page 25) and a spin box, circled below, for moving between different time steps.

2D Scene’s Views Properties panel
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Export Options
The export options for the .ORSObject file format now let you choose to export multiple 
objects as separate files or to include them in a single file.

Visual Plane Panel
A number of modifications were made to the Visual Plane panel, shown below.

Visual Plane panel

In this Dragonfly release, Visual Planes will appear in the Data Properties and Settings 
panel, where you can control the visibility of a visual plane and add effects such as clip, 
edge contrast, window leveling, and others (see Shapes Panel on page 8 for more 
information about planes).

Support for 4K Displays
This software release features additional support for users who choose to work with 4K 
displays.

Developer Documentation
The developer documentation for Dragonfly has been updated for version 3.5. Choose 
Help > Dragonfly Developer Documentation on the menu bar to open the 
documentation system.
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Menu Item Changes
The following changes and new menu items are implemented for Dragonfly 3.5.

Menu Bar Items
A number of new items, listed below, have been added to the File, Tools, and Developer 
menus.

New menu bar items

Dataset Pop‐Up Menu
A number of new items, listed below, and other changes have been implemented for the 
dataset pop-up menu. These are listed below.

Dataset pop‐up menu changes

Annotation Menu
A number of new items, listed below, and other changes have been implemented for the 
annotation pop-up menu. These are listed below.

Annotation pop‐up menu changes

Description

File menu

Open Plugins Lets you directly access Dragonfly plugins from a drop-down menu.

Tools menu

Active Contour Opens the Active Contour panel (see Active Contour on page 5).

Execute DOS Command Opens the Command dialog, in which you can enter common DOS commands.

Developer menu

Instance Observer Opens the Instance Observer panel. Refer to the Dragonfly developer documentation for more 

information about the Instance Observer.

Profiler Opens the Profiler panel, in which you can wrap a method dynamically and monitor the timing of an 

operation. Refer to the Dragonfly developer documentation for more information about the Profiler.

Description

Apply Registration to Other 

Dataset(s)

Lets you apply the transformations used to register a dataset to another dataset.

Align Centroid With Lets you align the centroid of the selected dataset with a reference object (see Align Centroids on 

page 27).

Apply Transformation From Lets you apply transformations, such as translations and rotations, that were applied to a reference object 

to the selected dataset (see Apply Transformations on page 27).

New Dataset from Marked 

Slices

Lets you extract a new dataset from marked image slices (see New Dataset from Marked Slices on 

page 26).

Normalize Histogram Lets you normalize the histogram of a selected dataset to the histogram of a reference dataset (see 

Normalize Histogram on page 26).

Overwrite Dataset Lets you overwrite the intersecting values of a dataset with the values of another dataset (see Overwrite 

Dataset on page 27).

Description

Apply Transformation From Lets you apply transformations, such as translations and rotations, that were applied to a reference object 

to the selected annotation (see Apply Transformations on page 27).
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Region of Interest Menu
A number of new items, listed below, and other changes have been implemented for the 
region of interest pop-up menu. These are listed below.

Region of interest pop‐up menu changes

Multi‐ROI Menu
A number of new items, listed below, and other changes have been implemented for the 
multi-ROI pop-up menu. These are listed below.

Multi‐ROI pop‐up menu changes

Mesh Pop‐Up Menu
A number of new items, listed below, and other changes have been implemented for the 
pop-up menu for meshes. These are listed below.

Mesh pop‐up menu changes

Description

Invert Lets you invert the axis representation(s) and values of a region of interest (see Invert on page 19).

Generate Contour Mesh Lets you generate a contour mesh from a region of interest (see Generate Contour Mesh on page 18).

Align Centroid With Lets you align the centroid of the selected region of interest with a reference object (see Align Centroids 

on page 27).

Apply Transformation From Lets you apply transformations, such as translations and rotations, that were applied to a reference object 

to the selected region of interest (see Apply Transformations on page 27).

Create a Signed Distance 

Map

Lets you create a signed distance map, in which the deviation between two regions of interest is shown as 

a colored map.

Align Axis of Inertia Lets you align the axis of inertia of a region of interest with another ROI (see Align Axis of Inertia on 

page 19).

Look at Center of Mass Lets you automatically align the center of mass of a region of interest in the views of a scene (see Look at 

Center of Mass on page 19).

New Binary Image from ROI Automatically creates a new dataset(s) in which the labeled voxels in the selected region(s) of interest are 

assigned a value of 1 and unlabeled voxels are assigned a value of 0.

Resample Geometry Was previously named Resample Shape.

Description

Invert Lets you invert the axis representation(s) of a multi-ROI (see Invert on page 19).

Delete Selected Scalar 

Values

Lets you delete scalar measurements from a multi-ROI (see Delete Scalar Values on page 22).

Copy Scalar Values From Lets you copy scalar values from one multi-ROI to another (see Copy Scalar Values on page 22).

Align Centroid With Lets you align the centroid of the selected multi-ROI with a reference object (see Align Centroids on 

page 27).

Apply Transformation From Lets you apply transformations, such as translations and rotations, that were applied to a reference object 

to the selected multi-ROI (see Apply Transformations on page 27).

Resample Geometry Was previously named Resample Shape.

Description

Mesh Decimator Lets you reduce the number of vertices, edges, and triangles in a mesh (see Mesh Decimator on 

page 14).

Mesh Registration Lets you register a mesh with a reference (see Mesh Registration on page 15).

Signed Deviation Map Lets you create a signed distance map, in which the deviation between two meshes is shown as a colored 

map (see Deviation Maps on page 16).
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* Available only for meshes with scalar values.

Preferences Changes
Colors Preferences
Changes for the Colors preferences are indicated in the following table.

Colors preferences

3D Views Preferences
A new set of preferences are available in this Dragonfly release for 3D views.

3D Views preferences

Additional preferences changes are summarized below.

Configured Actions
The Configured Actions preferences now include a description of their associated state.

System Requirements Changes
This release supports the base system requirements. Any differences in those 
requirements are noted below.

System requirements changes

Deviation Map Lets you create a distance map, in which the deviation between two meshes is shown as a colored map  

(see Deviation Maps on page 16).

Delete a Scalar Value Slot* Lets you delete selected measurements from scalar meshes (see Delete Scalar Values on page 17).

Map Scalar Values From Lets you map scalar values contained in a mesh or multi-ROI to the selected mesh (see Map Scalar 

Values on page 16).

Copy Scalar Values From Lets you map scalar values contained in a mesh to the selected mesh (see Copy Scalar Values on 

page 16).

Align Centroid With Lets you align the centroid of the selected mesh with a reference object (see Align Centroids on page 27).

Apply Transformation From Lets you apply transformations, such as translations and rotations, that were applied to a reference object 

to the selected mesh (see Apply Transformations on page 27).

Description

Description

Shape lines Lets you select the colors for selected and unselected shape lines (see Shapes Panel on page 8).

Description

Default to orthographic 

perspective

If selected, 3D scene views will appear in Orthographic Projection mode by default (see Orthographic 

Projection Mode on page 22).

Version Changes to system requirements

3.0.0 None.

3.1.0 None.

NOTE Dragonfly 3.1 includes a new Anaconda distribution for Python. You should note that the current 

version of Python accessed by Dragonfly will be updated automatically to version 3.6 when you install this 

new release.

3.5.0 None.
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Extending Dragonfly
Dragonfly’s Infinite Toolbox, an open exchange platform for the Dragonfly user 
community, lets you submit, browse, and download extensions that implement new 
features and workflows for all of your image processing or analysis needs.

Choose Tools > Infinite Toolbox on the menu bar to open Dragonfly’s Infinite Toolbox.

Getting Help
Learning Dragonfly
Just by taking a quick look around www.theobjects.com/dragonfly, you’ll find some 
great free resources, such as our latest instructional videos, recorded webinars, and 
user forums.

Reporting Issues
Dragonfly includes an integrated reporting module that lets you include comments and 
other information along with generated DMP and log files whenever you encounter an 
issue that results in a crash or application freeze.

Send Report to ORS dialog

You should note that you can also report an issue at any time by choosing Help > 
Report an Issue on the menu bar.

Request a New Feature
Let us know if you have a suggestion for a new feature, or an idea for an improvement 
to an existing workflow.
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